Indigitization - Slides Digitization Manual
Compiled by Jennifer Deol
University of British Columbia
Supervisor: Sarah Dupont
LIBR 569A: Professional Experience
August 10, 2018

Contents
Formats Covered in this Manual ..........................................................................................................3
Before Getting Started ..........................................................................................................................3
Selection, Examination and Condition Assessment .....................................................................3
Cleaning Procedure for Slides .......................................................................................................4
File Management ...........................................................................................................................5
Physical Storage of Slides ..............................................................................................................6
Scanning .................................................................................................................................................8
Before Getting Started ..................................................................................................................8
Setting Colour Profile ....................................................................................................................8
Guidelines for Determining Resolution ........................................................................................9
Scanning Slides ................................................................................................................................... 10
Scanning 35mm Slides ................................................................................................................ 13
Making a Contact Sheet ............................................................................................................. 16
Post-Scanning Digitalization Workflow ............................................................................................. 17
Saving for Preservation and Access ........................................................................................... 17
Saving & File Formatting ............................................................................................................ 18
Metadata..................................................................................................................................... 19
Digitizing Fragile and Large Slides ..................................................................................................... 21
Glossary of Terms ............................................................................................................................... 22
Additional Resources.......................................................................................................................... 23
References .......................................................................................................................................... 24
Appendix A: Condition Assessment Report – Storage Unit.............................................................. 25
Appendix B: Condition Assessment Report – Slides ......................................................................... 26

2

Formats Covered in this Manual
Format
35mm slides

6x6cm slides
Odd sized slides (i.e., magic lantern slides)

Brief description
Small, positive pieces of film, normally about
1.375" by .875", held by rectangles of cardboard
or plastic
Medium format slides
Anywhere from medium to large format slides

Before Getting Started
Selection, Examination and Condition Assessment
Selection of materials to digitize (Adapted from Indigitization Toolkit, 2018)
The purpose for digitization projects and daily scanning activities generally fall into one of the following
categories:
• Information Sharing: To enable users to directly access and use, a range of materials where
copyright and agreements allow
• Supporting Research: To build a critical mass of digital content to support research, programs,
and activities.
• Preservation: To preserve rare and fragile materials and those at risk of format obsolescence,
while also improving access to their content by providing digital copies of the items for use.

The value (or worth) of the materials, as well as the positive aspects of access to them in electronic form,
will rationalize the amount of time and effort spent in accomplishing a digitization project. All digitization
activities and projects need to consider the following selection criteria
•

•
•
•

Value
o

Informational Value – records that provide significant information on key people, places,
events, objects, periods, activities, processes, and projects, etc.
o Administrative Value – records that have functional usefulness to an organization
o Archival Value – rare or unique cultural material with intrinsic value to its users
Use and Demand
o Highly used or accessed materials
o Materials that are currently difficult to access
Risk
o Materials at risk of loss or deterioration o Rate of technological change
Rights
o Intellectual property rights and moral considerations o Materials made available for
research
o Information in the public domain
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Examination (Adapted from Haberle & Korns, 2012)
The condition and order of the slides should be noted before beginning the digitization process as well.
To understand the scope and nature of the event being documented and digitized, the contents of all files
and slides for a given event should be examined to determine image orders, duplicates, modifications or
any damage to the slide. The chronological sequence of these slides may also be significant to note,
especially slides that are of dynamic time-based performances or events.

Begin by separating and grouping slides for your project and making note of the following:
1. Group slides by source or donor. If the source is unknown, the slide can be grouped by the image
content/ event
2. Names on the labels that processed and mounted the slide (usually printed on the emulsion side
of the mount)
3. Additional information on slide mount (i.e., photographer name, date)
4. General content (i.e., multiple photographs of the same instance taken from different
perspectives, distinct lighting/ coloration / quality that sets images apart from others)
5. Duplicates (i.e., mounts that have the word duplicate printed on the emulsion side, generally
don’t have a frame number embedded in the film when removed from mount and/or have
increased contrast compared to original)
6. Mounting material (i.e., cardboard, plastic)
7. Any other additional information, such as information about legal rights for the slide
Once sorted and prioritised, it is recommended to conduct a condition assessment report of the slides.
For project management purposes, when you have more than one person working on a digitizing project,
it is good practice to note who digitized items, on what date, and what condition the items were in to
keep a paper trail.
For an example of condition assessment reports see Appendix A: Condition Assessment Report – Storage
Unit and Appendix B: Condition Assessment Report – Slides you can use as a template and adapt for your
project. It is recommended that the project manager edit these templates as required for the specific
needs of the digitization project. These procedures and forms were developed as a template that you
may use for your condition assessment. There are many ways to conduct a conditions assessment, and
this method – using a paper template – is simply one of them. You may also want to consider entering the
information into an excel spreadsheet or some other electronic format.
At this stage any necessary treatment to stabilise or prepare the slides for digitization should also be
carried out. The most common treatment required is cleaning and repair. Cleaning of the glass slides
involves removal of any surface dirt, fingerprints, accretions and adhesive marks from the glass that
would otherwise obscure the image when it is digitised (see Cleaning Procedure for Slides section)

Cleaning Procedure for Slides (Adapted from Lawson, et al. (n.d.); Franklin Furnace Archive, 2012; Kennedy, 2012)
Standard Physical Cleaning
Prior to scanning, clean slides using a dry lens brush (preferably anti-static) followed by a few blasts of
pressurized air to blow dust off the item being scanned. Keep the slides clean throughout the process and
ensure there are no fingerprints or debris on the scanner surface glass or the slide.
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Fingerprints and dust can significantly reduce the quality of an archival image. They are most noticeable
on small items that are greatly enlarged, such as slides, and can be very difficult to correct after scanned.
While dust cannot be eliminated entirely, you should take every effort to reduce it in the workplace and
on the slide throughout the digitization process. It is recommended to use cotton gloves when handling
slides and to work in a clean, dust free environment when handling and scanning slides.
Intensive Physical Cleaning
If dust or fingerprints persists, use a soft cloth (a PEC*PADs wipe), or negative/film cleaning solution, such
as PEC-12, which works exceptionally well for dirty slides.

File Management (Adapted from Franklin Furnace Archive, 2012, Lai et al., 2016)
Long-term preservation of digital master files requires a storage and migration strategy. It is good practice
to store digital objects in several places with a consistent naming scheme for long-term accessibility and
findability. The first step is to determine where you will store your images (i.e., network server, external
hard drives, a database, etc.). Some questions to think through:
• Will you store them on the local computer temporarily because the scans will be faster?
• Will you move the files to a networked drive, or a portable storage drive?
• Will you scan directly to networked location?
Next, decide the folder structure for the images:
• Will you create a project hierarchy or use an arbitrary numbering system?
• Avoid deep folder hierarchies.
• Be consistent (don’t use special characters in the folder names).
• Determine your file naming strategy before you start your project.
• Consider using the scanning software’s ability to auto generate numbers. Using this sequencing
ability of auto generated numbers can help prevent duplicate numbers and can speed up
processing. For example, the Epson scanner allows you to create a prefix and a three digit
number that is auto generated as in:
Prefix: abc02 Start Number: 001 for a filename abc02001.tif or Prefix: 2016-06-12_ Start number:
001 for a filename 2016-06-12_001.tif.
• Follow file-naming best practices (below).
We recommend the following file-naming conventions and best practices:
• Keep file names short, but use adequate identifying information.
• Use characters (a-z) and (0-9) and avoid upper-case.
• Do not use spaces or special characters (such as / . , “ ‘ ? ! % * ^ @ [ ] etc.).
• Use underscores or hyphens to separate elements in the file name and help to make them more
readable.
• If using dates use YYYYMMDD or YYYY-MM-DD.
• Use the period (.) only before the file extension as in .tiff or .jpg and always make sure the file
extension is included in the filename.
• Use filenames that correspond to the original media, if practical for the prefix (converting spaces
to underscores, developing project codes to shorten and avoiding special characters, and then
use the automated numbers for sequences, where possible.
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•

For corrected and access versions, maintain the original filename for the master and add codes
for the type. For example, for a corrected master you could add a “c” as in 2016-06-12_001c.tif.

Additional Resources to consult for File Management best practices:
See Indigitization Toolkit Section B5: Naming Conventions: http://indigitizationtoolkit.sites.olt.ubc.ca/files/2018/03/B5-2018.pdf
Indigitization Toolkit Section F: File Management: http://indigitizationtoolkit.sites.olt.ubc.ca/files/2018/03/K1-2018.pdf

Physical Storage of Slides (Adapted from Archival Methods, 2017; The U.S. National Archives and Records Administration, 2017).
Due to cost and physical storage capacity, you will have to consider whether you will retain or dispose the
physical slide material after the content has been digitized. It is important to keep in mind that digital
image file management requires a deep and longstanding institutional commitment. Routine back-up
procedures of digital files are not sufficient to permanently preserve the digital files you create.
This is because the digital content may become unusable due to current hardware and/or software
becoming obsolete in the future. The risk of loss is also high, especially when migrating digital files to
future systems for maintenance, functionality and accessibility as new technologies arise. If you are able
to commit to the long-term and sustainable digital preservation and accessibility plan of these digital files
then perhaps you can consider disposing of the physical slides.
Note: To learn more about digital preservation, see Indigitization Toolkit Section I. Digital Preservation:
http://www.indigitization.ca/indigitization-toolkit/digital-preservation/
Slides take up minimal space, and preservation best practice is to retain the analogue version for future
reference or use and can serve as a back-up if the digital copy becomes mis-filed or lost. If you need to
dispose of the physical slides, ensure you have thought about a data management plan to account for
changing technology and future digitization needs.
If you decide to retain the physical slides in-house, slides can be stored the same way as photographic
prints or negatives. If you have the budget for it, best practice is to use high-quality papers and plastic
which pass the ANSI IT9.16 Photographic Activity Test (PAT).1 Plastic boxes made of polypropylene are
usually safe to store slides.
Slides can also be stored in plastic slide pages (a type of pocket page which holds 20 slides) and placed in
3-ring archival binders, acid-free boxes or stored in metal or cardboard slide boxes.

The PAT was developed by the American National Standards Institute (ANSI) and is a test that determines whether or not a storage material will
cause fading or staining in photographs.
1
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Bulk storage options
35mm slide storage system: this compact “box-within-a-box-within-a-box” system can safely store up to
1200 cardboard or plastic-mounted slides, or about 600 glass-mounted slides. A 35mm slide 2400 slide
storage kit is also available for purchase.

(Source: https://www.archivalmethods.com/blog/preserving-35mm-slides/)

Storing glass slides (Adapted from http://www.ala.org/alcts/preservationweek/advice/lanterns)
Glass slides are best stored in four-flap wrappers (to prevent scratching the glass) and vertically in boxes.
You will want to store the slides vertically rather than horizontally because glass is heavy. Particularly, old
glass is very brittle and the bottom slide could crack under the weight of fellow slides in the pile. If your
slides don't take up the entire box, put in some sort of spacer or padding so that the slides don't slide
down. Label the box as having glass to prevent damage during future handling.
Tip: Negatives and slides should be stored in a cool, dry location.

If you do not have much budget or storage space, storing slides in the ring cases that come with them in
plastic boxes in cool, dark, dust free environments is acceptable but is not recommended for long-term
preservation of slide material. Other methods described above are more suitable for long term storage
than the ring case.
Note: For an in-depth introduction to preservation of images, negatives and slides see “Paper, glass,
plastic: Identification and care of photographic negatives (2017)” presentation in Additional Resources
section.
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Scanning
Before Getting Started (Adapted from Kennedy, 2012; Lai et al., 2016; Indigitization Toolkit, n.d.)
Equipment Needed:
Scanner
Computer
Software:
Scanning software
Editing software
Storage

Selecting a Scanner
For plastic and other reflective items like slides, most recent scanners can produce adequate archival
images. For medium formats like 6x6 slides and odd-sized formats mid-level consumer grade flatbed
scanners can produce adequate images for good practices. For 35 mm negatives or slides a more
expensive scanner and a slide holder is needed to meet the criteria for best practices.
Recommended: The Epson Scanner
The Espon Scanner scans 35-mm filmstrips, 35-mm slides, medium format film, 4x5 inch film, and oddsized film and slides.
Note: For an equipment and step-by-step guide for scanning using the Epson Expression 10000XL Scanner
see “Photographic Image Digitization Workshop Manual Part 2: Scanning with the Epson Expression
10000XL Scanner.”
Nikon Film Scanner
Nikon film scanners work best for 35 mm film and slides and easily meet the resolution criteria for best
practices. Unfortunately, Nikon has stopped manufacturing film scanners and the limited market for film
scanners makes it unlikely that other companies will develop high-end film scanners in the future. Used
and refurbished Nikon scanners can be found.
Cleaning and set-up procedure for scanner
It is important throughout the digitization process that you keep the scanner free of any dust, debris and
fingerprints. You can use compressed air spray to remove dust. Be sure to use as directed so that no
canister residue lands on the scanner glass.

To remove grease and fingerprints, use pre-treated E-WIPES lens or scanner wipes, or a small amount of
glass cleaner on a soft lint-free cloth. Dry the document table glass afterwards. Never spray glass cleaner
directly on the document table. Always spray it on a cloth first, and then wipe the glass.
Do not place the scanner on an unstable surface.

Setting Colour Profile (Adapted from Lai et al., 2016; Nault Norton-Wisla, 2017)
Setting the color profile is critical to digital capture and can be set within the scan software prior to digital
scanning. A color profile simply describes the range of colors, or gamut, that a camera can see, a printer
can print, or a monitor can display. They are used so that we can get as close to some proximity of a
colour standard across monitors and printers.
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Color profiles are device-independent and determine a color range you can work in. They allow you to
edit images in a controlled, consistent manner. We recommend Adobe RGB, which allows for greater
color information to be captured about the original item and allows for conversion or downsizing to a
narrow space later. Not all hardware and software combinations produce the same color and tonal
conversion, and even this workflow will not always produce the same results across all output devices.
Recommended colour profile for colour images: Adobe RGB 1998 is recommended for colour images.
Recommended colour profile for black-and-white images: Gray Gamma 2.2 is recommended for grayscale
images.
Setting the Colour Profile for an Epson Scanner
Colour profiles can be set in the scan software (i.e., EPSON Scan) configuration settings before you start
scanning.

1. Open scan software from desktop application. A scan window will appear
2. Click the Configuration button at the bottom of the scan window. Configuration dialog box will open.

Guidelines for Determining Resolution (Adapted from Lai et al., 2016; Nault Norton-Wisla, 2017)
Resolution is the number of pixels in each dimension that can be displayed and is measured in pixels using
units DPI or PPI (pixels per inch). For instance, a 100 x 100 pixel image that is printed in a 1-inch square
could be said to have 100 dots per inch (DPI) or 100 pixels per inch (PPI). Used in this way, the
measurement is meaningful when printing an image. Good quality photographs usually require a
minimum of 300 dots per inch when printed.
In order to produce an archival quality image file that will print at good quality up to 12 inches at the
longest side, use the following table to determine the scan DPI or PPI resolution size:
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Table: Spatial Resolutions for Slides (Adapted from Kennedy, 2012; Photo Digitization Guide)
Original Longest
To print longest
(RECOMMENDED)
Scanner Type +
Slide Sizes
Side
side to 12” at 300
To print longest
Scanner Mode
dpi scan at dpi/ppi: side to 12” at 600
dpi scan at dpi/ppi:
35 mm slide
36 x 24 mm
2700
5400
Epson & Nikon;
use slide holder to
scan
6 x 6 Slide
56 x 56 mm
1632
3264
Epson; use flat
bed
Larger, or Oddmeasure longest
Use size for
Use size for
Epson; use flat
sized slides
side
Photograph*
Photograph*
bed
*to see various photograph resolutions, see pg. 15 of Photograph Image Digitization Workshop Manual (from Lai et al., 2016)

To set the colour profile go into the scanner software and select “Resolution” and input appropriate PPI.

Scanning Slides (Adapted from Lai et al., 2016)
1. Turn on the scanner.
2. Check the calibration to ensure scanner is performing optimally.
3. Ensure the scanner and slides are clean, give the scanner document glass a quick blast of canned
air to clean dust particles off.
4. Load the slides into the appropriate slide film holder landscape oriented, shiny side face-down
and emulsion side face-up. Be sure to have a proper grip on glass slides when handling as they
may slip from your grasp due to the fabric of your gloves and get damaged.
5. Ensure slides in film holder are also clear of any dust, debris and fingertips. Follow procedures to
ensure your scanner is clear of any dust or debris (see section Before Getting Started).
6. Lay the loaded slide holder onto scanner glass so arrow mark from the film holder matches up
with the arrow mark on the scanner.
7. Close scanner lid and scan.
8. Open scanner’s scan program from desktop applications and follow instructions to set preview,
colour-profile, resolution and file saving settings. Then hit OK.
9. The scanner will start batch scanning any images you have marquee-ed.
10. When finished, remove the film holder from scanner glass.
11. Return the slides to its place of storage.
12. Turn off the scanner.
Note: Avoiding newton rings for glass slides can be tricky. Newton's Rings are a distortion that looks like
moiré silk caused by the two layers of glass of the slide. There are two ways that you can avoid the
Newton's rings to get a good scan. First, you can scan on a flatbed scanner that has the capability of
scanning with transmitted light (scanning light in the lid shining through the slide to the scanner) using a
mount to raise the slide off of the scanner glass. A second way is to place the glass slide on a light box and
shoot with a camera with no other flash or light source. With both of these methods, be sure to check the
digital image to ensure that the color is correct. If not, you may have to adjust this in Photoshop or some
other photo manipulation program but save the original scan or camera raw image as a master.
Alternatively, you can purchase anti-newton glass slide mounts.
(Adapted from http://www.ala.org/alcts/preservationweek/advice/lanternslides)
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Scanning 35mm Slides
A step-by-step guide of scanning 35mm slides adapted from “Photographic Image Digitization Workshop
Manual Part 2: Scanning with the Epson Expression 10000XL Scanner” pg. 9-12.

5. Open scanner software (i.e. Espon Scan) and select professional mode from dropdown
box.
6. Insert the following colour profile, resolution and additional image adjustments. See
Epson Scan window for an example of the information you want to set in the scan
software dialogue box.
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Making a Contact Sheet (Kennedy, 2012; Lai et al., 2016)

Contact sheets contain thumbnails of each scanned image of your project. For project management
workflow purposes, when working with slides you may want to make contact sheets so you can track the
numbers you have assigned to the slides; however, this is optional and generally for smaller slide
digitization projects. You do not have to do one.
1. Follow directions for slide scanning.
2. Scan all slides according to slide scanning instructions in section Scanning Slides above
3. Write file names on the slides in pencil (Note: use pencil only, do not use ink or pen to write
on slides as it will damage the slide).
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4. Label the slide storage unit (i.e., a slide sleeve, box or carousel) with file name range. Note
that the individual file name for a given slide deck is written on the slide itself and the file
name range is written on the sleeve or box or carousel, or whatever a group of slides are
stored in).
5. Apply appropriate metadata template to uncorrected (preservation copy) files in Adobe
Bridge (or Photoshop).
6. Open files in Photoshop. Perform necessary orientation, cropping, and attach colour profile
for each individual digitized slide to be saved.
7. Save (preservation copy) file to the folder where the master images are stored.
8. Perform any additional corrections to file; levels and curves adjustments as needed as per
(Part 4: Post-Scanning, Image Adjustment and Correction) then Save As file to appropriate
corrected folder with file name+c (if using “c” to indicate “corrected”).
9. Consider using a spreadsheet to record the image description. Name the spreadsheet to
reflect the project or collection you are working on and the date you begin (YYYYMMDD
format). Note that this step is not necessary. Depending on what kind of collection
management/digital collection software you use, the data may be able to be batch uploaded
into a system directly. If you do not have a system in place yet, this is a way to record the data
in such a way it can be added to a system at a later date.
10. Save contact sheet to the appropriate folder and consider including the range of file numbers
assigned to these images in the contact sheets as part of the file name.
11. Print out a copy of the contact sheet.
12. File with slides after scanning and numbering.

Post-Scanning Digitalization Workflow
Saving for Preservation and Access (Kennedy, 2012; Lai et al., 2016; Indigitization Toolkit, n.d.)
For each object scanned, you will produce two files:
• Digital Master (also referred to as uncorrected version) = the adjusted, but uncorrected scanned
image file, frequently called the uncorrected master in this manual for preservation of original
slide.
• Access Master (also referred to as correction version) = a copy of the digital master which is
corrected to enhance access and/or downsized for publishing or printing. Also referred to as the
corrected master or edited master, this is a lower res version for accessibility and use.
Digitization must strive to preserve to the greatest extent possible the authenticity and integrity of the
original information. Adjustments made to the Digital Master image are made to optimize image quality
and bring all images to a common rendition, to produce the most accurate visual representation of the
original.
Post-Scanning Adjustments include:
• Cropping the image
• Rotating and straightening the image
• Assigning a color profile
Note: For a step-by-step image adjustment to Digital Master using Photoshop see “Photo Digitization
Guide Section G2” pg. 8-12: http://www.indigitization.ca/indigitization-toolkit/photograph-digitization/
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Digital enhancements may be performed only on copies of the digital master file to improve access. The
digital master file must be kept unaltered. Corrections are made to an Access Master, or derivative file of
the Digital Master image to enhance the visual image and make it more accessible and viewable, and for
the purpose of reproducing for specific print or display.
Post-Scanning Corrections include:
• Tone correction (levels, tone balance, contrast, highlights, shadows)
• Color correction (white balance, saturation)
• Touching up, dust and scratch removal
• Sharpening the image
Note: For a step-by-step image adjustment to Access Master using Photoshop see “Photo Digitization
Guide Section G2” pg. 12-27: http://www.indigitization.ca/indigitization-toolkit/photograph-digitization/
Saving & File Formatting (Lai et al., 2016; Indigitization Toolkit, n.d.)
Now that you have created a digital and access masters, you are ready to save your files. The standard
format for archiving master images is uncompressed TIFF. TIFF files are a universally accessible and
lossless format that generally does not degrade the quality of the image over time (Kennedy, 2012; Lai et
al., 2016).
Saving in JPEG and PDF is not recommended. While JPEG format may be appropriate for master images in
certain situations (i.e., JPEG files may also be used for master images if digital storage space is a
limitation), JPEG format compresses the image and produces slight degradation each time the image is
modified and re-compressed. Repeated editing of an image can cause significant degradation over time.
The PDF format is increasingly used to share and store electronic documents; however, PDF files from
scanning are images in compressed formats with parameters that are not easily understood or controlled.
The following tables contain standards summarized from various industry standards that should be
followed for all digitization projects if possible. By adhering to these accepted standards, we are able to:
• Ensure that the digital files created through digitization are of high quality and meet national and
international standards, and
• Maintain the integrity and longevity of the digital files for long term digital preservation.
These standards are subject to change as technology and practice evolve. Furthermore, each digitization
project is unique in its setting and goals. The ultimate objective is to have a preservation master copy that
is a faithful reproduction of the original from which additional copies can be made.
Film, negatives, and slides
Preservation and
Print Access
Screen Access
Thumbnail
Access Master
File format
TIFF
JPEG or PNG
JPEG or PNG
JPEG or PNG
Resolution
800 – 1200 dpi
150 – 300 dpi
150 dpi
150 dpi
Bit depth
24 bit RBG colour 24 bit RBG colour 24 bit RBG colour 24 bit RBG colour
or 8 bit grayscale
or 8 bit grayscale
or 8 bit grayscale
or 8 bit grayscale
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Dimensions

Compression

4000 – 6000 pixels
across the long
edge
Uncompressed

3000 pixels across
the long edge

800 pixels across
the long edge

200 pixels across
the long edge

Lossless
compression

Lossless
compression

Lossless
compression

Saving for print
Note: If you are saving to print or use in a document, you may want to make the image smaller, to exactly
the print size you need.
1. From the menu, choose Image->Image Size.
a. The Image Size dialog box will appear. Ensure that all three boxes at the bottom are
checked; Scale Styles, Constrain Proportions, and Resample Image.
2. Change the Document Size to the appropriate size you want to print to in inches or cm or mm.
The Resolution should be a minimum of 72 pixels/inch, but ideally for print you would want to
use 300 pixels/inch.
3. Change the very bottom dropdown choice to:
a. “Bicubic Sharper” (best for reductions) if you are making the image (and file size) smaller.
4. You shouldn’t be enlarging, but if you are, choose Bicubic Smoother (best for enlargement), if you
are making the image (and file size) larger.
5. Click OK.
6. If you are happy with the size and quality of the resulting image, choose the Save As option from
the menu bar File ->Save As
a. From the Save As dialog, there are a number of file formats to choose from, including
JPEG, PNG, and TIFF. These are all acceptable for print or use in documents.
Saving for web
1. If you want to product an image for the web, choose
a. File->Save for Web and Devices
2. The Save for Web & Device dialog box will appear.
a. From here there are a number of options you can choose. You should specify the exact
Image Size width and height in pixels, and you can preview any combination of choices.
And you can save to a number of default web optimized preferences for GIF, JPEG and
PNG.
3. After you have entered your desired options, hit the Save button and your choice of web
optimized image will be created. You will be asked where you want to save the image.

Metadata (Lai et al., 2016; Indigitization Toolkit, n.d.,)
Metadata is structured information that describes and makes it easier to find, use, or manage an
information resource. Metadata is often called data about data or information about information. For
example, metadata recorded for a digital image or photograph would include data about the content of
the image, the photographer, the date of creation, date(s) of modification, technical information such as
resolution, file type, file format, and its relationship with other related files and their locations.
For more information about working with and managing metadata for a digitization project see:
http://indigitization-toolkit.sites.olt.ubc.ca/files/2018/03/H-2018.pdf
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Best practices for creating metadata for photographic material
Avoid using grammatical markings that may be translated by different programs, like backslash ( / ) ,
colons ( : ) , and semicolons ( ; ) as they may cause problems if merged into another database. Spaces or
safe markings, such as a dash, are OK. In file naming, insure that file extensions are included with a
preceding period (.). Avoid periods in other positions in the file name.

In addition to the unchangeable embedded technical metadata, it is possible to append additional
metadata that is embedded in the image file. This additional metadata is editable. Using Adobe Bridge, it
is possible to create individualized templates and apply them to batches of images.
To create a metadata template:
1. Start Photoshop from the Applications on the desktop. Adobe Bridge will open with an image
browser window. Or, open Photoshop directly.
2. Navigate to the folder that contains the images to which you want to append metadata (see
Directory section following). Previews of the images/files will appear in the “Content” column. If
you select one particular image, a larger thumbnail and its metadata will appear on the right.
3. Open the Create Metadata Template dialog box from the menu bar.
a. Choose Tools -> Create Metadata Template...
b. The Create Metadata Template dialog box will appear.
4. Enter the appropriate metadata to the fields into the IPTC Core section.
Creator:
Name of Photographer (if known, otherwise leave blank)
Creator: Job Title
i.e., “Photographer” (leave blank is no name in Creator field)
Source:
i.e., “UBC Irving K. Barber Learning Centre (IKBLC)”
Copyright Notice:
i.e., Copyright held by …[Owner of material or Photographers
Name] (leave blank if not know)
Copyright Status:
This should be determined in advance for collections, fonds, or
individual images as required. If copyrighted, select “Copyrighted”
from the drop down list; if not known leave default “Unknown”
Rights Usage Terms:
(contents dependent on project; leave blank if unknown or
undecided at point of scanning)
5. Click the Save button to save the Template. Check to make sure the template is saving to the
Templates folder.
Note: For a sample metadata template see: http://indigitization-toolkit.sites.olt.ubc.ca/files/2018/03/H42018.pdf
Apply Metadata to Digital Master Image
Later, when you use the Digital Master to create any corrected versions, all derivative copies will inherit
the metadata intact. This way the Digital Master and subsequent access images, or any derivatives, will
have consistent metadata.
Completing a spreadsheet for each project or collection digitized
In order to keep track of digitizing an “item-level” spreadsheet can be completed for each project or
collection. The following outlines how to complete the spreadsheet.
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Note: If the data in each spreadsheet might be imported into another management system or database,
consider using the old Excel format (Excel 97-2003 Workbook) and make sure all the data cells are set as
“text” or make sure that the data type for any set of cells will transfer properly to the other system. Date
and number fields can be challenging to make compatible.

Digitizing Fragile and Large Slides (Adapted from Kennedy, 2012)
If your slides are fragile or too large for your scanner, digitization using a digital camera to capture the
slide image is the most common option. The decisions about color mode, color space, resolution, and bit
depth apply with a camera and the same criteria are used. A digital camera used with a copy stand or
book cradle is a good option for digitizing items that are too fragile or too large to scan. The camera
should be an SLR or have a similarly large sensor.
Note: For a step-by-step guide for scanning using a camera see Sustainable Heritage Network: How to
scan with the Camera resource under Additional Resources section below.
The best practice is to set the master image size to match the size of the original item. Good practice is to
record the sizes of the originals in the documentation for an image and change the default size later only
if needed to reproduce the original size.
The resolution settings for cameras are described in terms of total pixels on each side of the image rather
than pixels per inch. Cameras are categorized according to the maximum total number of pixels in an
image. A useful guideline is that a 6 or 7-megapixel image is needed to have 3000 pixels on the longest
side and an 11 or 12 megapixel image is needed to have 4000 pixels on the longest side. The possible
settings for resolutions on a camera are limited to fixed values.
A digital SLR camera corresponding to 35 mm can produce good quality images for archival purposes. A
minimum of 12 megapixels are needed for standard sized documents, and greater megapixels are
preferred for oversize or highly detailed photographs or documents. The prices are currently beyond the
range of most people or organizations with budget limitations.
Saving a camera image
Many cameras do not produce TIFF files as output. The common options are RAW and JPEG. RAW images
are directly from the camera sensor with little processing. The main processing to produce the final image
must be done in a later step with Photoshop Camera Raw or with software provided with the camera.
Working with RAW images provides the maximum control but also requires the greatest expertise and
time. RAW images are proprietary and are not suitable for archival purposes. After the image has been
processed, it can be saved in TIFF format.
Note if your camera does not provide TIFF files for digitization and you cannot download the Photoshop
Camera Raw software, high quality JPEG output files may be used as the master images rather than
converting the JPEG files to TIFF. The drawback with JPEG format is it compresses the image and produces
slight degradation each time the image is modified and re-compressed.
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Glossary of Terms
Contact sheet is a positive print of all the negative images/slides from one deck, made by a contact
printing process so that all the images are the same size and are side by side to see which are the best
images on a film/deck of slides.
DPI stands for dots per inch, and is a measurement of resolution for referring to the number of physical
dots of ink in a printed document (the higher the DPI, the better the tonality of the image). The DPI
setting of the scanner relates to the final real size of the image.
PPI stands for pixels per inch, and is a measurement for a digital image (the higher the dpi, the better the
quality of the digital image). The PPI setting of the scanner relates to the final pixel size of the digital
image.
Grayscale refers to an image in which the value of each pixel is a single sample composed exclusively of
shades of grey.
JPEG stands for Joint Photographic Experts Group and refers to a type of graphics file format commonly
used for images, photographs, etc.
Resolution is the number of pixels in each dimension that can be displayed or the density of pixels in the
image.
TIFF stands for Tagged Image File Format and refers to a type of file format for storing images.
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Additional Resources
Digitizing magic lantern slides URL: http://www.ala.org/alcts/preservationweek/advice/lanternslides
This website provides guidelines and standards for digitizing magic lantern slides and can be referenced
when working with odd-sized glass slides.
Digitization Best Practices (York University) URL:
https://www.library.yorku.ca/web/collections/digitalscholarship/digitization-best-practices/
This website provides a high-level overview of considerations for digitization projects, as well as links to
further resources.
Image Digitisation Manual 2007 URL:
http://www.slq.qld.gov.au/__data/assets/pdf_file/0006/63879/SLQ_PQ_image_digitisation_manual__complete.pdf
The manual provides information on the key aspects of planning and conducting a digitization project.
Metadata best practices and guides URL: http://indigitization-toolkit.sites.olt.ubc.ca/files/2018/03/H12018.pdf
Part of the Indigitization toolkit, this detailed guide is a good introduction to working with metadata for
community digitization projects.
Guides to Quality in Visual Resource Imaging, (Digital Library Federation) URL:
http://old.diglib.org/pubs/dlf091/dlf091.htm
These guides were written for those who have already decided what they will digitize and what purposes
the digital images will serve and cover project planning, scanner selection, imaging system set-up, and the
resulting digital masters. The website has not been maintained since 2010.
Library of Congress Sustainable Formats Digitization Image Standards URL:
https://www.loc.gov/preservation/digital/formats/intro/intro.shtml
This site provides analysis of the technical aspects of digital formats and Library of Congress standards for
digitizing images.
Sustainable Heritage Network (n.d.) How to scan with a camera URL:
https://www.sustainableheritagenetwork.org/system/files/atoms/file/HowToScanWithTheCamera3.pdf
A visual step-by-step guide for scanning using a camera.
Fischer, M., (2017) Paper, glass, plastic: Identification and care of photographic negatives. ATALM annual
conference. Retrieved from Sustainable Heritage Network URL:
https://www.sustainableheritagenetwork.org/digital-heritage/paper-glass-plastic-identification-and-carephotographic-negatives
In this video, Monique Fischer, Senior Photograph Conservator at the North East Document Conservation
Center (NEDCC), offers an in-depth introduction to the preservation of negatives, including their
identification, deterioration, and care. Some of the topics covered include: how to recognize various
formats, the preservation problems associated with each format type, storage concerns and preservation
priorities, environmental guidelines and proper care and handling.
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Appendix A: Condition Assessment Report – Storage Unit

Assessment Date: __________________________
Project Name: _____________________________
Digitization Tech: ___________________________
Storage Unit Condition
Number of slides in unit:
Storage unit container Type: (i.e., 3-ring binder sleeves, slide carousels, cardboard/plastic box, etc.):
Is the storage unit container broken or damaged?
Is the storage unit container well supported to protect slides?

Additional storage unit notes:

Storage Unit Label Notes
Date on label:
Photographer/donor/ lab/ primary participant name(s):

Label summary and relevant label notes:
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Appendix B: Condition Assessment Report – Slides
Assessment Date: ________________________
Project Name: ___________________________
Digitization Tech: _________________________

Slides
Number of slides in unit:
Storage unit container Type: (i.e., 3-ring binder sleeves, slide carousels, cardboard/plastic box, etc.):
Are any of the slides damaged or broken?
Are there any duplicate slides?

Additional slide notes:

Slide label notes
Date on label:
Photographer/donor/ lab/ primary participant name(s):

Label summary and relevant label notes:
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